
 

1.2.1 Department wise Add on /Certificate/Value added programs 

.  

S.No Content 

 1.  IQAC Resolution Model 

2.  Certificate Courses  conducted by the  following Departments–  

Chemistry 

 Zoology  

Computers Science 

Computer Applications 

English 

 Commerce 

Statistics 

Mathematics 

 Course programmes are attached 

 rest are provided in College Website link 

3 http://gdcrlykoduru.edu.in/1-2-1-certificate-programs/ 
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Govt. Degree College, Kodur (RS), Kadapa Dt. 

Certificate Course  

IQAC -Resolution copy 

 

The IQAC committee along with Chair person and Coordinator, convened a 
meeting on 20-7-2018   and resolved to conduct “ Certificate/ Value Add-
on courses “ in the month of  August 2018 according to the feasibility of the 
departments.It is also resolved to submit the details as per the checklist well in 
advance by the departments who had given their consents. 

Check list: 

1. IQAC Resolution 

 
2. Department wise Resolution 

 
3. Course structure and planning 

 
a. Date and timing schedule 

 
b. Course out comes, Syllabus and model question papers 

 
c. Testing procedure 

 
d. Feedback form 

 
e. Model Certificate 

 
4. Students’ enrolment list 

 
5. Attendance register for 30 hours and more (Online/ Offline) 

 
6. Audio visual Aids (if available), PPTs, Handouts/ Printed material 

 
7. Test(Exam) and Certificate distribution 

 
8. Submission of Critical Analysis Report to IQAC 



Department Resolution Copy 

 

Department of  Computer Applications 

 

 

As per the circular issued by the IQAC dated 20-7-2018  Department of Computer 

Applications has conducted a meeting on 21-7-2018  and unanimously resolved to conduct a 

Certificate / Value add-on course in the month of   August 2018 with the duration of a minimum 

of 30 hours. 

 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

Notice Board 

 

 

 

The Department of Co mp u t e r  Ap p l i c a t i o n s  is going to conduct a certificate course on 

“Digital Awareness ”, from  1-8-2018 with min 30 working hours. 

 

 
   Interested candidates should come and register your names in the department on and before  27-7-

2018 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

DEPARTMENT OF COMPUTER APPLICATIONS 

A Certificate Course in “Digital Awareness” 
 

 

Syllabus 
 

 
1. Introduction  cyber space, internet 

2. Need of Digitalization 

3. Good things we can do on internet 

4. Thing not to be done on internet 

5. Netiquette  



6. Thing to be aware of while using internet 

7. How to indentify cyber frauds 

8. How to protect you device from cyber threats 

9. How to  create Email account  

10. Using mail groups for group communication 

11. Sending attachments, searching for data in mails, creating drafts 

12. How to digitalize existing hard copies, for effective store and forward 

13. Creating account in Facebook 

14. Communicating in Facebook 

15. Dos and Don’ts  while using Facebook 

 

 
Outline of the course in periods: 

1. Theory hours 15 

2. Hands on experiment 15 

Total hours allotted 30 
 



Certificate course on Digital Awareness 
Object of the course: 

 
To generate a good sound digital awareness to the students,  for safe and effective 

use of existing digital technologies. 

 
 

COURSE OUT COME 

 
Students will learn to make digital copies of the information, effective store, retrieve and forward 

techniques,  use mails, creating group mails, sending and receiving group messages, creating account 

in  Facebook and use it  safely. They will also learn Netiquette  

Student Enrolment list: 

 
S.No. Name of the Student Group Class/ 

 
Year 

Remarks 

1 B.Lakshmi prasanna B.Com(CA) II Year  

2 C.Prakash B.Com(CA) II Year  

3 C.Sateesh Kumar B.Com(CA) II Year  

4 K.Hari Krishna B.Com(CA) II Year  

5 M.Leela Kumar B.Com(CA) II Year  

6 N.Sukumar B.Com(CA) II Year  

7 S.Swathi B.Com(CA) II Year  

8 Y.Devamani B.Com(CA) II Year  

9 K.Madhuprasad B.Com(CA) III Year  

10 M.Guntanna B.Com(CA) III Year  

11 M.Ramakrishna B.Com(CA) III Year  

12 M.Kavitha B.Com(CA) III Year  

13 P.Rajeswari B.Com(CA) III Year  

14 S.Naresh B.Com(CA) III Year  

15 S.Anusha B.Com(CA) III Year  

16 T.Karunakar B.Com(CA) III Year  



Introduction 
 

 

Digital literacy has become one of the most important skills of the 21st century. And we’ve 
every reason to believe that this won’t change for some time—perhaps even forever.  

The ability to know how to utilize digital platforms and technological devices has the potential 
to make your life much easier. In contrast, a lack of this knowledge is potentially hugely 
limiting.  

Many of the skills and jobs that are in demand right now require comprehensive digital 
experience. This puts those without them at a distinct disadvantage.  

 
 

 

 

 

 

1. Introduction to cyberspace and the internet: 
Cyberspace and the internet: what are they? 

The history of the internet and how it has evolved over time. 

The benefits of the internet and how it has changed the way we live, work, and 

communicate. 

The challenges of cyberspace and how they impact our privacy and security. 

2. Need for digitalization: 
The benefits of digitalization in various fields like healthcare, education, and 

business.How digitalization can improve efficiency, reduce costs, and increase 

accessibility. 

The impact of digitalization on the economy and job market. 

The challenges of digitalization and how to address them. 

3. Good things we can do on the internet: 
Online learning and educational resources. 

Online shopping and e-commerce. 

Connecting with friends and family through social media. 

Accessing information and news from around the world. 

Participating in online communities and forums. 

4. Things not to be done on the internet: 
Sharing personal information or financial details with strangers. 



Cyberbullying and online harassment. 

Downloading or sharing pirated content. 

Engaging in illegal activities like hacking or phishing. 

Spreading false information or rumors. 

5. Netiquette: 
The basic rules of online etiquette and communication. 

How to write professional and effective emails. 

Avoiding online conflicts and disagreements. 

Respecting others' privacy and opinions. 

The importance of tone and language in online communication. 

6. Things to be aware of while using the internet: 
Cybersecurity threats like malware, phishing, and hacking. 

Protecting personal information and passwords. 

Using secure networks and avoiding public Wi-Fi. 

Identifying fake news and scams. 

The impact of social media on mental health and well-being. 

7. How to identify cyber frauds: 
Recognizing phishing emails and scams. 

Understanding social engineering tactics used by fraudsters. 

Identifying fake websites and offers. 

Checking the authenticity of online sellers and businesses. 

Reporting cyber fraud to the relevant authorities. 

8. How to protect your device from cyber threats: 
Using strong passwords and two-factor authentication. 

Installing antivirus and anti-malware software. 

Keeping software and operating systems up-to-date. 

Avoiding suspicious downloads and links. 

Backing up important data and files. 

9. How to create an email account: 
Choosing a secure and reliable email provider. 

Creating a username and password. 

Filling in personal information and contact details. 

Setting up email preferences and security settings. 

Verifying the account and starting to use it. 

10. Using mail groups for group communication: 
Creating a mail group and adding members. 

Sending group emails and attachments. 

Replying and forwarding group emails. 

Setting up group preferences and rules. 

Managing group membership and removing members. 

 

 

 

 

 

11. Sending attachments, searching for data in mails, creating drafts: 
Attaching files and documents to emails. 

Compressing large files for easier sharing. 



Searching for specific emails or keywords in your inbox. 

Creating and saving email drafts for later use. 

Adding signatures and formatting emails for clarity. 

12. How to digitalize existing hard copies for effective storage and forwarding: 
Scanning and converting physical documents to digital format. 

Organizing and storing digital files on a computer or cloud storage. 

Sharing digital files securely with others. 

Backing up digital files for safekeeping. 

Destroying physical copies to protect sensitive information. 

13. Creating an account in Facebook: 
Signing up for a Facebook account. 

Setting up a profile picture and cover photo. 

Filling in personal information and interests. 

Connecting with friends and family on Facebook. 

Managing privacy settings and security features. 

 

14. Communicating in Facebook: 
Sending messages to individual users or groups. 

Using Facebook Messenger for real-time communication. 

Commenting on posts and pages. 

Creating and participating in events. 

Using Facebook Live for video communication. 

15. Dos and Don'ts while using Facebook: 
Dos: 

Set privacy settings to limit access to personal information. 

Use strong and unique passwords for Facebook. 

Think before posting and avoid sharing sensitive or inappropriate content. 

Engage in respectful and constructive discussions with others. 

Use Facebook for networking and professional purposes. 

Don'ts: 

Share personal information like phone numbers or home addresses. 

Engage in cyber bullying or online harassment. 

Share fake news or rumors. 

Add strangers as friends without verifying their identity. 

Use Facebook for illegal or unethical activities. 
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Certificate Course  on Digital Awareness 

Feedback form: 

Course feedback form: 
 

 
1. Were objectives of the course clear to 

you 1)Yes 2). No 

2. The course contents met your expectations 

1) Yes 2) No 

3. The level of the course was 

1) Good 2)Not Good 

4. The contents were illustrated with 

1) More examples 2) Few examples 

5. The course exposed you to new knowledge and practices 

1) Agree 2) Not agree 

6. Will you recommend this course to your next Batch 

1) Yes 2) No 



Critical Analysis Report: 

The Department of Computer Applications  has  conducted a certificate course 
on “Digital Awareness ” from 01-08-2018 to  31-080-2018  with the minimum 
duration of 30 hours. According to the IQAC and Principals instruction the 
course have been started the feasibility and convenient of the hours for this 
academic year. The total students 23were registered for this course and 
completed as per the schedule. The objective of the course was fulfilled by 
acquiring Digital Awareness, Protecting from cyber crimes, creating and 
managing E-Mails, how to create account on Facebook and manage the 
Facebook account. 

Outcomes of the Course: 
1. Students understood the basic concepts and terminologies of Cyber Space 

and the Internet 
2. Students have learnt significance of digitalization in modern-day society 
3. Students have learnt the positive aspects of using the internet for social, 

personal, and  
        professional purposes 
4.  They understood the potential risks and threats associated with the use of 

the internet 
5.  Students have learnt to identify harmful and illegal activities that should be 

avoided   
        online 
6. Students understood the basic rules of online etiquette and good behavior 
7. Students understood the potential risks and vulnerabilities associated with 

online activities 
8. Students understood the different types of cyber frauds and scams. Analyze 

the potential  consequences of falling prey to cyber frauds 
9. Students understood the different types of cyber threats and attacks 
10.  Students have learnt strategies for protecting personal devices and data 

from cyber  
        threats 
11. Students have learn how to create Email account, and communicate through 

mail  
12. Students understood how to use mail groups for group communication 
13. They have learnt, how to send attachments, searching for data in mails, 

creating drafts 
14.  Students have learn how to digitalize existing hard copies, for effective store 

and forward 
15. Students have learnt the process of creating account in Facebook, and 

communicating 
16.  Students have learn the Dos and Don’ts  while using Facebook 
 

Hence, the certificate course “Digital Awareness”  is very useful to B.Com (CA), 



Students. The feedback from students were collected and analyzed. All the 

students  showed interest to do such type of Certificate course and to 

continue it for further years also. 

 

 
 

 

GOVT.DEGREE COLLEGE: KODUR(RS) 

IQAC -Resolution copy 

 

 
The IQAC committee along with Chair person and Coordinator, convened a meeting on 

     20/06/2022   and resolved to conduct .   Certificate/ Value Add-on courses “ in the 

month of  June 2022 according to the feasibility of the departments. 

It is also resolved to submit the details as per the checklist well in advance by the departments 

who had given their consents. 

Check list: 

1. IQAC Resolution 

 

2. Department wise Resolution 

 

3. Course structure and planning 

 

a. Date and timing schedule 

 

b. Course out comes, Syllabus and model question papers 

 

c. Testing procedure 

 

d. Feedback form 

 

e. Model Certificate 

 

4. Students’ enrolment list 

 

5. Attendance register for 30 hours and more (Online/ Offline) 

 

6. Audio visual Aids (if available), PPTs, Handouts/ Printed material 

 

7. Test(Exam) and Certificate distribution 



 

8. Submission of Critical Analysis Report to IQAC



 

Department Resolution Copy 

Department of  Statistics 

 

As per the circular issued by the IQAC dated  20/06/2022 the department of 
 

  Statistics  has conducted a meeting on  20/06/2022 and unanimously resolved to conduct a 

Certificate / Value add-on course in the month of  June 2022  with the duration of a minimum 

of 30 hours. 

 

 

 

 

 

 

 

Notice Board 

The department of statistics is going to conduct a certificate course on “Statistics: A do it 

yourself on EXCEL”, from  01/07/2022   with min 30 working hours. 

 

 
Interested candidates should come and register your names in the department on and before 

           27/06/2022



DEPARTMENT OF STATISTICS:: GDC, KODUR  

A Certificate Course in “Statistics: A Do It Yourself on EXCEL” 
 

 

Syllabus 

 

 
1. Introduction on Statistical Packages 

2. EXCEL screen 

3. Entering Data 

4. Create Graph 

5. Line chart 

6. Bar chart 

7. Pie chart 

8. Scatter plot 

9. Straight lines 

10. Descriptive Statistics 

11. Statistical functions 

12. t- test 

13. F-test 

14. ANOVA 

15. Model Test 

 

 
Outline of the course in periods: 

1. Theory hours 15 

2. Hands on experiment 15 

Total hours allotted 30



Object of the course: 

 

To generate a good sound knowledge on using Statistical functions in EXCEL for all 

Mathematical Students in the institution with free of cost. 

 

 
 

COURSE OUT COME 

 

Students will learn to understand the statistical concepts and apply them in MS- EXCEL easily. 

They should know the EXCEL concepts well in advance. After completion of this certificate 

course, all the students should get familiar knowledge in using MS- EXCEL commands and 

functions like min, max, count, average, median, mode, range, standard deviation, correlation, 

regression, t-test, F-test, ANOVA test, Diagrams and Charts etc., 

 

 

Student Enrolment list: 

 

SN

O 

Roll No Name of the Student Group 

1 216028054001 C. REDDY GANESH 
I B.Sc(M.S.Cs) 

2 216028054002 G. SIVA KUMAR 
I B.Sc(M.S.Cs) 

3 216028054003 J. BALAJI 
I B.Sc(M.S.Cs) 

4 216028054004 J. SUPRAJA 
I B.Sc(M.S.Cs) 

5 216028054006 K. SWATHI 
I B.Sc(M.S.Cs) 

6 216028054008 L. YUVA TEJA 
I B.Sc(M.S.Cs) 

7 216028054009 M.PALLAVI 
I B.Sc(M.S.Cs) 

8 216028054011 S. NOOR MOHAMMAD 
I B.Sc(M.S.Cs) 

9 216028054012 S. VISHNU 
I B.Sc(M.S.Cs) 

10 216028054013 S. SUSMITHA 
I B.Sc(M.S.Cs) 

11 216028054014 U. SOWMYA 
I B.Sc(M.S.Cs) 

 
Total No of Registered Students:11 



Introduction 

 
 

MS-EXCEL is a part of Microsoft Office suite software. It is an electronic spreadsheet with 

numerous rows and columns, used for organizing data, graphically represent data(s), and 

performing different calculations. It consists of 1048576 rows and 16384 columns, a row and 

column together make a cell. Each cell has an address defined by column name and row 

number example A1, D2, etc. this is also known as a cell reference. 

 

Cell references: The address or name of a cell or a range of cells is known as Cell reference. 

It helps the software to identify the cell from where the data/value is to be used in the 

formula. We can reference the cell of other worksheets and also of other programs. 

 

● Referencing the cell of other worksheets is known as External referencing. 

● Referencing the cell of other programs is known as Remote referencing. 

 

There are three types of cell references in Excel: 

 

1. Relative reference. 

2. Absolute reference. 

3. Mixed reference.



 
 

 
 

The Ribbon in MS-Excel is the topmost row of tabs that provide the user with different 

facilities/functionalities. These tabs are: 
 
 

1. Home Tab: It provides the basic facilities like changing the font, size of text, editing 

the cells in the spreadsheet, autosum, etc.



2. Insert Tab: It provides the facilities like inserting tables, pivot tables, images, clip 

art, charts, links, etc. 

3. Page layout: It provides all the facilities related to the spreadsheet-like margins, 

orientation, height, width, background etc. The worksheet appearance will be the 

same in the hard copy as well. 

4. Formulas: It is a package of different in-built formulas/functions which can be used 

by user just by selecting the cell or range of cells for values. 

5. Data: The Data Tab helps to perform different operations on a vast set of data like 

analysis through what-if analysis tools and many other data analysis tools, removing 

duplicate data, transpose the row and column, etc. It also helps to access data(s) from 

different sources as well, such as from Ms-Access, from web, etc. 

6. Review: This tab provides the facility of thesaurus, checking spellings, translating the 

text, and helps to protect and share the worksheet and workbook. 

7. View: It contains the commands to manage the view of the workbook, show/hide 

ruler, gridlines, etc, freezing panes, and adding macros. 

 

Creating a new spreadsheet: 

 

In Excel 3 sheets are already opened by default, now to add a new sheet : 

 

● In the lowermost pane in Excel, you can find a button. 

● Click on that button to add a new sheet.



 
 

 

 

 

 
 

● We can also achieve the same by Right-clicking on the sheet number before which 

you want to insert the sheet. 

● Click on Insert.



 
 

● Select Worksheet. 

● Click OK.



 

 

 
 

Opening previous spreadsheet: 

 

On the lowermost pane in Excel, you can find the name of the current sheet you have opened. 

 

On the left side of this sheet, the name of previous sheets are also available like Sheet 2, 

Sheet 3 will be available at the left of sheet4, click on the number/name of the sheet you want 

to open and the sheet will open in the same workbook. 

 

For example, we are on Sheet 4, and we want to open Sheet 2 then simply just click on 

Sheet2 to open it.



 
 

 

 

 

 

 

 

 

 

Managing the spreadsheets: 

 

You can easily manage the spreadsheets in Excel simply by : 

 

● Simply navigating between the sheets.



 
 

 

 

 

● Right-clicking on the sheet name or number on the pane. 

● Choose among the various options available like, move, copy, rename, add, delete etc. 

● You can move/copy your sheet to other workbooks as well just by selecting the 

workbook in the To workbook and the sheet before you want to insert the sheet in 

Before sheet.



 
 

To save the workbook: 

 

1. Click on the Office Button or the File tab. 

2. Click on Save As option. 

3. Write the desired name of your file. 

4. Click OK. 

 

To share your workbook: 

 

1. Click on the Review tab on the Ribbon. 

2. Click on the share workbook (under Changes group). 

3. If you want to protect your workbook and then make it available for another user 

then click on Protect and Share Workbook option. 

4. Now check the option “Allow changes by more than one user at the same time. This 

also allows workbook merging” in the Share Workbook dialog box. 

5. Many other options are also available in the Advanced like track, update changes. 

6. Click OK. 

 

Ms-Excel shortcuts: 

 

1. Ctrl+N: To open a new workbook. 

2. Ctrl+O: To open a saved workbook. 

3. Ctrl+S: To save a workbook.



4. Ctrl+C: To copy the selected cells. 

5. Ctrl+V: To paste the copied cells. 

6. Ctrl+X: To cut the selected cells. 

7. Ctrl+W: To close the workbook. 

8. Delete: To remove all the contents from the cell. 

9. Ctrl+P: To print the workbook. 

10. Ctrl+Z: To undo. 

 

 
Excel screen 

 

 

 
Entering Data 

A new worksheet is a grid of rows and columns. The rows are labelled with numbers, and the 

columns are labelled with letters. Each intersection of a row and a column is a cell. Each cell 

has an address, which is the column letter and the row number. The arrow on the worksheet 

to the right points to cell A1, which is currently highlighted, indicating that it is an active cell. 

A cell must be active to enter information into it. To highlight (select) a cell, click on it. 

To select more than one cell: 

Click on a cell (e.g. A1), then hold the shift key while you click on another (e.g. D4) to select 

all cells between and including A1 and D4. 

Click on a cell (e.g. A1) and drag the mouse across the desired range, unclicking on another 

cell (e.g. D4) to select all cells between and including A1 and D4. 

To select several cells which are not adjacent, press "control" and click on the cells you want 

to select. Click a number or letter labelling a row or column to select that entire row or 

column. 

One worksheet can have up to 256 columns and 65,536 rows, so it will be a while before you 

run out of space. 

Each cell can contain a label, value, logical value, or formula. 

Labels can contain any combination of letters, numbers, or symbols.



Values are numbers. Only values (numbers) can be used in calculations. A value can also be a 

date or a time 

Logical values are "true" or "false." 

Formulas automatically do calculations on the values in other specified cells and display the 

result in the cell in which the formula is entered (for example, you can specify that cell D3 is 

to contain the sum of the numbers in B3 and C3; the number displayed in D3 will then be a 

function of the numbers entered B3 and C3). 
 

To enter information into a cell, select the cell and begin typing. 

Note that as you type information into the cell, the information you enter also displays in the 

formula bar. You can also enter information into the formula bar, and the information will 

appear in the selected cell. 

When you have finished entering the label or value: 

Press "Enter" to move to the next cell below (in this case, A2) 

Press "Tab" to move to the next cell to the right (in this case, B1) 

Click in any cell to select it 

Entering Labels 
 

Unless the information you enter is formatted as a value or a formula, Excel will interpret it 

as a label, and defaults to align the text on the left side of the cell. 

If you are creating a long worksheet and you will be repeating the same label information in 

many different cells, you can use the AutoComplete function. This function will look at other 

entries in the same column and attempt to match a previous entry with your current entry. For 

example, if you have already typed "Wesleyan" in another cell and you type "W" in a new 

cell, Excel will automatically enter "Wesleyan." If you intended to type "Wesleyan" into the 

cell, your task is done, and you can move on to the next cell. If you intended to type 

something else, 

e.g. "Williams," into the cell, just continue typing to enter the term.



To turn on the AutoComplete function, click on "Tools" in the menu bar, then select 

"Options," then select "Edit," and click to put a check in the box beside "Enable 

AutoComplete for cell values." 

Another way to quickly enter repeated labels is to use the Pick List feature. Right click on a 

cell, then select "Pick From List." This will give you a menu of all other entries in cells in 

that column. Click on an item in the menu to enter it into the currently selected cell. 

Entering Values 

A value is a number, date, or time, plus a few symbols if necessary to further define the 

numbers [such as: . , + - ( ) % $ / ]. 

Numbers are assumed to be positive; to enter a negative number, use a minus sign "-" or 

enclose the number in parentheses "()". 

Dates are stored as MM/DD/YYYY, but you do not have to enter it precisely in that format. 

If you enter "jan 9" or "jan-9", Excel will recognize it at January 9 of the current year, and 

store it as 1/9/2002. Enter the four-digit year for a year other than the current year (e.g. "jan 9, 

1999"). To enter the current day's date, press "control" and ";" at the same time. 

Times default to a 24 hour clock. Use "a" or "p" to indicate "am" or "pm" if you use a 12 hour 

clock (e.g. "8:30 p" is interpreted as 8:30 PM). To enter the current time, press "control" and 

":" (shift-semicolon) at the same time. 
 

An entry interpreted as a value (number, date, or time) is aligned to the right side of the cell, 

to reformat a value. 

Rounding Numbers that Meet Specified Criteria: To apply colours to maximum and/or 

minimum values: 

Select a cell in the region, and press Ctrl+Shift+* (in Excel 2003, press this or Ctrl+A) to 

select the Current Region. 

From the Format menu, select Conditional Formatting. 

In Condition 1, select Formula Is, and type =MAX($F:$F) =$F1. 

Click Format, select the Font tab, select a colour, and then click OK. 

In Condition 2, select Formula Is, and type =MIN($F:$F) =$F1. 

Repeat step 4, select a different colour than you selected for Condition 1, and then click OK. 

Note: Be sure to distinguish between absolute reference and relative reference when entering 

the formulas.



Rounding Numbers that Meet Specified Criteria 

Problem: Rounding all the numbers in column A to zero decimal places, except for those that 

have "5" in the first decimal place. 

Solution: Use the IF, MOD, and ROUND functions in the following formula: 

=IF(MOD(A2,1)=0.5,A2,ROUND(A2,0)) 

To Copy and Paste All Cells in a Sheet 

Select the cells in the sheet by pressing Ctrl+A (in Excel 2003, select a cell in a blank area 

before pressing Ctrl+A, or from a selected cell in a Current Region/List range, 

pressCtrl+A+A). OR 

Click Select All at the top-left intersection of rows and columns. 

Press Ctrl+C. 

Press Ctrl+Page Down to select another sheet, then select cell A1. 

Press Enter. 

To Copy the Entire Sheet 

Copying the entire sheet means copying the cells, the page setup parameters, and the defined 

range Names. 

Option 1: 

Move the mouse pointer to a sheet tab. 

Press Ctrl, and hold the mouse to drag the sheet to a different location. 

Release the mouse button and the Ctrl key. 

Option 2: 

Right-click the appropriate sheet tab. 

From the shortcut menu, select Move or Copy. The Move or Copy dialog box enables one to 

copy the sheet either to a different location in the current workbook or to a different 

workbook. Be sure to mark the Create a copy checkbox. 

Option 3: 

From the Window menu, select Arrange. 

Select Tiled to tile all open workbooks in the window. 

Use Option 1 (dragging the sheet while pressing Ctrl) to copy or move a sheet. 

Sorting by Columns 

The default setting for sorting in Ascending or Descending order is by row. To sort by 

columns: From the Data menu, select Sort, and then Options. 

Select the Sort left to right option button and click OK.



In the Sort by option of the Sort dialog box, select the row number by which the columns will 

be sorted and click OK. 

 

 
Descriptive Statistics 

The Data Analysis Tool Pak has a Descriptive Statistics tool that provides you with an easy 

way to calculate summary statistics for a set of sample data. Summary statistics includes 

Mean, Standard Error, Median, Mode, Standard Deviation, Variance, Kurtosis, Skewness, 

Range, Minimum, Maximum, Sum, and Count. This tool eliminates the need to type 

individual functions to find each of these results. Excel includes elaborate and customisable 

toolbars, for example the "standard" toolbar shown here: 
 

Some        of        the         icons         are         useful         mathematical         computation: 

is the "Autosum" icon, which enters the formula "=sum()" to add up a range of cells.  

is the "FunctionWizard" icon, which gives you access to all the functions available.  is the 

"GraphWizard" icon, giving access to all graph types available, as shown in this display: 
 

Excel can be used to generate measures of location and variability for a variable. Suppose we 

wish to find descriptive statistics for a sample data: 2, 4, 6, and 8. 

Step 1. Select the Tools *pull-down menu, if you see data analysis, click on this option, 

otherwise, click on add-in.. option to install analysis tool pak. 

Step 2. Click on the data analysis option. 

Step 3. Choose Descriptive Statistics from Analysis Tools list. 

Step 4. When the dialog box appears:



Enter A1:A4 in the input range box, A1 is a value in column A and row 1, in this case this 

value is 2. Using the same technique enter other VALUES until you reach the last one. If a 

sample consists of 20 numbers, you can select for example A1, A2, A3, etc. as the input 

range. 

Step 5. Select an output range, in this case B1. Click on summary statistics to see the 

results. Select OK. 

When you click OK, you will see the result in the selected range. 

As you will see, the mean of the sample is 5, the median is 5, the standard deviation is 

2.581989, the sample variance is 6.666667, the range is 6 and so on. Each of these factors 

might be important in your calculation 

of different statistical procedures. 

 

 
Create a Chart 

 
To create a line chart, execute the following steps. 

 

1. Select the range A1:D7. 
 

2. On the Insert tab, in the Charts group, click the Line symbol. 

 
 

3. Click Line with Markers.



 
 

Result: 
 

Note: enter a title by clicking on Chart Title. For example, Wildlife Population. 

Change Chart Type 

 
You can easily change to a different type of chart at any time. 

 

1. Select the chart. 
 

2. On the Chart Design tab, in the Type group, click Change Chart Type.



 
 

3. On the left side, click Column. 
 

 

4. Click OK. 

Result:



 

 

Switch Row/Column 

 
If you want to display the animals (instead of the months) on the horizontal axis, execute the 

following steps. 

1. Select the chart. 
 

2. On the Chart Design tab, in the Data group, click Switch Row/Column. 
 

Result: 



 

 

Legend Position 
 

To move the legend to the right side of the chart, execute the following steps. 
 

1. Select the chart. 
 

2. Click the + button on the right side of the chart, click the arrow next to Legend and click 

Right. 

Result: 
 

 
Data Labels



You can use data labels to focus your readers' attention on a single data series or data point. 
 

1. Select the chart. 
 

2. Click a green bar to select the Jun data series. 
 

3. Hold down CTRL and use your arrow keys to select the population of Dolphins in June 

(tiny green bar). 

4. Click the + button on the right side of the chart and click the check box next to Data Labels. 
 

Result: 
 

 
 

Pie Chart 

 
 

Pie charts are used to display the contribution of each value (slice) to a total (pie). Pie charts 

always use one data series. 

To create a pie chart of the 2017 data series, execute the following steps.



1. Select the range A1:D2. 
 

2. On the Insert tab, in the Charts group, click the Pie symbol. 
 

3. Click Pie. 
 

Result:



 
 

4. Click on the pie to select the whole pie. Click on a slice to drag it away from the center. 
 

Result: 
 

Note: only if you have numeric labels, empty cell A1 before you create the pie chart. By 

doing this, Excel does not recognize the numbers in column A as a data series and 

automatically creates the correct chart. After creating the chart, you can enter the text Year 

into cell A1 if you like. 

Let's create one more cool pie chart. 
 

5. Select the range A1:D1, hold down CTRL and select the range A3:D3.

https://www.excel-easy.com/examples/data-series.html
https://www.excel-easy.com/examples/data-series.html


 
 

6. Create the pie chart (repeat steps 2-3). 
 

7. Click the legend at the bottom and press Delete. 
 

8. Select the pie chart. 
 

9. Click the + button on the right side of the chart and click the check box next to Data Labels. 
 

 

10. Click the paintbrush icon on the right side of the chart and change the color scheme of the 

pie chart.



 
 

Result: 
 

11. Right click the pie chart and click Format Data Labels. 
 

12. Check Category Name, uncheck Value, check Percentage and click Center.



 
 

Result: 
 

Note: right click the data labels and click Font to change the font size and font colour of the 

data labels.



Scatter Plot 

 
 

Use a scatter plot (XY chart) to show scientific XY data. Scatter plots are often used to find 

out if there is a relationship between variable X and Y. 

 

Only Markers 

To find out if there is a relationship between X (a person's salary) and Y (his/her car price), 

execute the following steps. 

1. Select the range A1:B10. 
 

 

2. On the Insert tab, in the Charts group, click the Scatter symbol. 
 

3. Click Scatter.



 
 

Result: 
 

Note: we added a trendline to clearly see the relationship between these two variables. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Straight Lines

https://www.excel-easy.com/examples/trendline.html


 

To create a scatter plot with straight lines, execute the following steps. 
 

1. Select the range A1:D22. 
 

2. On the Insert tab, in the Charts group, click the Scatter symbol. 
 

3. Click Scatter with Straight Lines.



 
 

Note: also see the subtype Scatter with Smooth Lines. 

Result: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Note: we added a horizontal and vertical axis title. The horizontal axis of a scatter plot is a 

value axis, so you have more axis scaling options (the same as a vertical axis which always is 

a value axis). 

 

 

Column Chart 

 
 

Column charts are used to compare values across categories by using vertical bars. 

To create a column chart, execute the following steps.

https://www.excel-easy.com/examples/axes.html#axis-titles
https://www.excel-easy.com/examples/axes.html#axis-scale
https://www.excel-easy.com/examples/axes.html#axis-scale


1. Select the range A1:A7, hold down CTRL, and select the range C1:D7. 
 

2. On the Insert tab, in the Charts group, click the Column symbol. 
 

3. Click Clustered Column. 
 

Result:



 
 

Note: only if you have numeric labels, empty cell A1 before you create the column chart. By 

doing this, Excel does not recognize the numbers in column A as a data series and 

automatically places these numbers on the horizontal (category) axis. After creating the chart, 

you can enter the text Year into cell A1 if you like. 

 
Line Chart 

 
 

Line charts are used to display trends over time. Use a line chart if you have text labels, 

dates or a few numeric labels on the horizontal axis. Use a scatter plot (XY chart) to show 

scientific XY data. 

To create a line chart, execute the following steps. 
 

1. Select the range A1:D7. 
 

2. On the Insert tab, in the Charts group, click the Line symbol.

https://www.excel-easy.com/examples/data-series.html
https://www.excel-easy.com/examples/data-series.html
https://www.excel-easy.com/examples/scatter-plot.html#straight-lines
https://www.excel-easy.com/examples/scatter-plot.html#straight-lines


 
 

3. Click Line with Markers. 
 

Result: 



Note: only if you have numeric labels, empty cell A1 before you create the line chart. By 

doing this, Excel does not recognize the numbers in column A as a data series and 

automatically places these numbers on the horizontal (category) axis. After creating the chart, 

you can enter the text Year into cell A1 if you like. 

Let's customize this line chart. 
 

To change the data range included in the chart, execute the following steps. 
 

4. Select the line chart. 
 

5. On the Chart Design tab, in the Data group, click Select Data. 
 

6. Uncheck Dolphins and Whales and click OK. 
 

 

Result:

https://www.excel-easy.com/examples/data-series.html
https://www.excel-easy.com/examples/data-series.html


 
 

To change the color of the line and the markers, execute the following steps. 
 

7. Right click the line and click Format Data Series. 
 

The Format Data Series pane appears. 
 

8. Click the paint bucket icon and change the line color.



 
 

9. Click Marker and change the fill color and border color of the markers. 
 

Result: 
 

To add a trendline, execute the following steps. 
 

10. Select the line chart. 
 

11. Click the + button on the right side of the chart, click the arrow next to Trendline and then 

click More Options.



 
 

The Format Trendline pane appears. 
 

12. Choose a Trend/Regression type. Click Linear. 
 

13. Specify the number of periods to include in the forecast. Type 2 in the Forward box.



 
 

Result:



 
 

To change the axis type to Date axis, execute the following steps. 
 

14. Right click the horizontal axis, and then click Format Axis. 
 

 

The Format Axis pane appears. 
 

15. Click Date axis.



 
 

Result: 
 

Conclusion: the trendline predicts a population of approximately 250 bears in 2024. 

 

 
Histogram 

 
 

This example teaches you how to make a histogram in Excel. 

1. First, enter the bin numbers (upper levels) in the range C4:C8.

https://www.excel-easy.com/examples/trendline.html


 
 

 

 

2. On the Data tab, in the Analysis group, click Data Analysis. 
 

Note: can't find the Data Analysis button? Click here to load the Analysis ToolPak add-in. 

3. Select Histogram and click OK. 

https://www.excel-easy.com/data-analysis/analysis-toolpak.html


4. Select the range A2:A19. 
 

5. Click in the Bin Range box and select the range C4:C8. 
 

6. Click the Output Range option button, click in the Output Range box and select cell F3. 
 

7. Check Chart Output. 
 

8. Click OK. 
 

9. Click the legend on the right side and press Delete. 
 

10. Properly label your bins. 
 

11. To remove the space between the bars, right click a bar, click Format Data Series and 

change the Gap Width to 0%.



12. To add borders, right click a bar, click Format Data Series, click the Fill & Line icon, 

click Border, and select a colour. 

Result: 
 

If you have Excel 2016 or later, simply use the Histogram chart type. 
 

13. Select the range A1:A19. 



14. On the Insert tab, in the Charts group, click the Histogram symbol. 
 

15. Click Histogram. 
 

Result. A histogram with 3 bins. 
 

Note: Excel uses Scott's normal reference rule for calculating the number of bins and the bin 

width. 

16. Right click the horizontal axis, and then click Format Axis.



 
 

The Format Axis pane appears. 
 

17. Define the histogram bins. We'll use the same bin numbers as before (see first picture on 

this page). Bin width: 5. Number of bins: 6. Overflow bin: 40. Underflow bin: 20. 

Result:



 
 

Recall, we made the following histogram using the Analysis ToolPak (steps 1-12). 
 

Conclusion: the bin labels look different, but the histograms are the same. ≤20 is the same as 

0-20, (20, 25] is the same as 21-25, etc.



Descriptive Statistics 

 
 

You can use the Analysis Tool pak add-in to generate descriptive statistics. For example, you 

may have the scores of 14 participants for a test. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To generate descriptive statistics for these scores, execute the following steps. 
 

1. On the Data tab, in the Analysis group, click Data Analysis. 

 
 

Note: can't find the Data Analysis button? Click here to load the Analysis ToolPak add-in. 

2. Select Descriptive Statistics and click OK. 
 

3. Select the range A2:A15 as the Input Range.

https://www.excel-easy.com/data-analysis/analysis-toolpak.html


4. Select cell C1 as the Output Range. 
 

5. Make sure Summary statistics is checked. 
 

6. Click OK. 

Result:



Statistical Functions 

This chapter gives an overview of some very useful statistical functions in Excel. 

Average 

To calculate the average of a group of numbers, use the AVERAGE function. 
 

Note: visit our page about the AVERAGE function for many more examples. 

 

Average if 

To average cells based on one criterion, use the AVERAGEIF function. For example, to 

calculate the average excluding zeros. 

Note: visit our page about the AVERAGEIF function for many more examples. 
 

 
 

Median 

To find the median (or middle number), use the MEDIAN function. 
 

Check:

https://www.excel-easy.com/examples/average.html
https://www.excel-easy.com/examples/averageif.html


 

 

Mode 

 
To find the most frequently occurring number, use the MODE function. 

 

Note: visit our page about the MODE function to learn more about this Excel function. 
 

Standard Deviation 

 
To calculate the standard deviation, use the STEDV function. 

 

Note: standard deviation is a number that tells you how far numbers are from their mean. Learn 

more about this topic on our page about standard deviation. 

Min 

 
To find the minimum value, use the MIN function. 

 

 
Max 

To find the maximum value, use the MAX function.

https://www.excel-easy.com/examples/mode.html
https://www.excel-easy.com/examples/standard-deviation.html


 

 

Large 

 
To find the third largest number, use the following LARGE function. 

 

Check: 
 

 

 

 
Small 

 
To find the second smallest number, use the following SMALL function. 

 

Check: 



Correlation 

 
 

The correlation coefficient (a value between -1 and +1) tells you how strongly two variables 

are related to each other. We can use the CORREL function or the Analysis Toolpak add- 

in in Excel to find the correlation coefficient between two variables. 

- A correlation coefficient of +1 indicates a perfect positive correlation. As variable X 

increases, variable Y increases. As variable X decreases, variable Y decreases. 

- A correlation coefficient of  -1 indicates a perfect negative correlation. As variable X 

increases, variable Z decreases. As variable X decreases, variable Z increases. 

 
 

- A correlation coefficient near 0 indicates no correlation. 
 

To use the Analysis Toolpak add-in in Excel to quickly generate correlation coefficients 

between multiple variables, execute the following steps.



1. On the Data tab, in the Analysis group, click Data Analysis. 
 

Note: can't find the Data Analysis button? Click here to load the Analysis ToolPak add-in. 

2. Select Correlation and click OK. 
 

3. For example, select the range A1:C6 as the Input Range. 
 

4. Check Labels in first row. 
 

5. Select cell A8 as the Output Range. 
 

6. Click OK.

https://www.excel-easy.com/data-analysis/analysis-toolpak.html


 
 

Result. 
 

Conclusion: variables A and C are positively correlated (0.91). Variables A and B are not 

correlated (0.19). Variables B and C are also not correlated (0.11) . You can verify these 

conclusions by looking at the graph. 

 

Regression 

 
 

This example teaches you how to run a linear regression analysis in Excel and how to 

interpret the Summary Output. 

Below you can find our data. The big question is: is there a relation between Quantity Sold 

(Output) and Price and Advertising (Input). In other words: can we predict Quantity Sold if 

we know Price and Advertising?



 
 

1. On the Data tab, in the Analysis group, click Data Analysis. 
 

Note: can't find the Data Analysis button? Click here to load the Analysis ToolPak add-in. 

2. Select Regression and click OK. 
 

3. Select the Y Range (A1:A8). This is the predictor variable (also called dependent variable). 

4. Select the X Range(B1:C8). These are the explanatory variables (also called independent 

variables). These columns must be adjacent to each other. 

5. Check Labels. 
 

6. Click in the Output Range box and select cell A11. 
 

7. Check Residuals. 
 

8. Click OK.

https://www.excel-easy.com/data-analysis/analysis-toolpak.html


 
 

Excel produces the following Summary Output (rounded to 3 decimal places). 

R Square 

R Square equals 0.962, which is a very good fit. 96% of the variation in Quantity Sold is 

explained by the independent variables Price and Advertising. The closer to 1, the better the 

regression line (read on) fits the data. 

Significance F and P-values 

To check if your results are reliable (statistically significant), look at Significance F (0.001). 

If this value is less than 0.05, you're OK. If Significance F is greater than 0.05, it's probably 

better to stop using this set of independent variables. Delete a variable with a high P-value 

(greater than 0.05) and rerun the regression until Significance F drops below 0.05. 

Most or all P-values should be below below 0.05. In our example this is the case. (0.000, 

0.001 and 0.005).



 

Coefficients 

The regression line is: y = Quantity Sold = 8536.214 -835.722 * Price + 0.592 * Advertising. 

In other words, for each unit increase in price, Quantity Sold decreases with 835.722 units. 

For each unit increase in Advertising, Quantity Sold increases with 0.592 units. This is 

valuable information. 

You can also use these coefficients to do a forecast. For example, if price equals $4 and 

Advertising equals $3000, you might be able to achieve a Quantity Sold of 8536.214 -

835.722 

* 4 + 0.592 * 3000 = 6970. 

Residuals 

The residuals show you how far away the actual data points are fom the predicted data points 

(using the equation). For example, the first data point equals 8500. Using the equation, the 

predicted data point equals 8536.214 -835.722 * 2 + 0.592 * 2800 = 8523.009, giving a 

residual 

of 8500 - 8523.009 = -23.009. 
 

 

You can also create a scatter plot of these residuals.



 
 

 

 

 

 

 

t-Test 

 
 

This example teaches you how to perform a t-Test in Excel. The t-Test is used to test the null 

hypothesis that the means of two populations are equal. 

Below you can find the study hours of 6 female students and 5 male students. 
 

H0: μ1 - μ2 = 0 

H1: μ1 - μ2 ≠ 0 

 
 

To perform a t-Test, execute the following steps. 
 

1. First, perform an F-Test to determine if the variances of the two populations are equal. This 

is not the case. 

2. On the Data tab, in the Analysis group, click Data Analysis.

https://www.excel-easy.com/examples/f-test.html
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Note: can't find the Data Analysis button? Click here to load the Analysis ToolPak add-in. 

3. Select t-Test: Two-Sample Assuming Unequal Variances and click OK. 
 

4. Click in the Variable 1 Range box and select the range A2:A7. 

5. Click in the Variable 2 Range box and select the range B2:B6. 

6. Click in the Hypothesized Mean Difference box and type 0 (H0: μ1 - μ2 = 0). 

7. Click in the Output Range box and select cell E1. 
 

8. Click OK. 

Result:

https://www.excel-easy.com/data-analysis/analysis-toolpak.html


1 2 

 
 

Conclusion: We do a two-tail test (inequality). lf t Stat < -t Critical two-tail or t Stat > t 

Critical two-tail, we reject the null hypothesis. This is not the case, -2.365 < 1.473 < 2.365. 

Therefore, we do not reject the null hypothesis. The observed difference between the sample 

means (33 - 24.8) is not convincing enough to say that the average number of study hours 

between female and male students differ significantly. 

 

 

 
F-Test 

 
 

This example teaches you how to perform an F-Test in Excel. The F-Test is used to test the 

null hypothesis that the variances of two populations are equal. 

Below you can find the study hours of 6 female students and 5 male students. 

H0: σ1
2 = σ2

2
 

H1: σ 2 ≠ σ 2 

 
 

To perform an F-Test, execute the following steps. 
 

1. On the Data tab, in the Analysis group, click Data Analysis.



 
 

Note: can't find the Data Analysis button? Click here to load the Analysis ToolPak add-in. 

2. Select F-Test Two-Sample for Variances and click OK. 
 

3. Click in the Variable 1 Range box and select the range A2:A7. 

4. Click in the Variable 2 Range box and select the range B2:B6. 

5. Click in the Output Range box and select cell E1. 
 

 

6. Click OK. 

Result:

https://www.excel-easy.com/data-analysis/analysis-toolpak.html


 
 

Important: be sure that the variance of Variable 1 is higher than the variance of Variable 2. 

This is the case, 160 > 21.7. If not, swap your data. As a result, Excel calculates the correct F 

value, which is the ratio of Variance 1 to Variance 2 (F = 160 / 21.7 = 7.373). 

Conclusion: if F > F Critical one-tail, we reject the null hypothesis. This is the case, 7.373 > 

6.256. Therefore, we reject the null hypothesis. The variances of the two populations are 

unequal. 

 

 

 
Test: 

Model Question Paper: 

 

 
Q.The function to calculate the Range of data in Excel is: 

RANGE.S() 

RANGE() 

MAX() - MIN () 

RANGE.P() 

Q.The following Excel function is used to find the mean of a number of items: 
 

=Average() 
 

=FindAverage() 
 

=Mean() 
 

=sum() 

Q.Which function returns the most frequently occurring number in a data set?



COUNT() 

MEDIAN() 

MODE() 

Don’t know 

Q.Which formula returns the arithmetic mean of the numbers in a data set? 
 

=AVERAGE(A1:A10) 
 

=MEDIAN(A1:A10) 
 

=SUM(A1:A10)/COUNT(A1:A10) 
 

Don’t know



 

Q

. 

What is the intersection of a column and a row on a worksheet called ? 

A. Column 

B. Value 

C. Address 

D. Cell 

Answer : Cell [Option : D] 

Q

. 

What type of chart is useful for comparing values over categories ? 

A. Pie Chart 

B. Column 

Chart C.Line 

Chart 

D. Dot Graph 

Answer : Column Chart [Option : B] 

Q

. 

Which function in Excel tells how many numeric entries are there ? 

A. NUM 

B. COUNT 

C. SUM 

D. CHKNUM 

Answer : COUNT [Option : B] 

Q

. 

A features that displays only the data in column (s) according to specified 

criteria 

A. Formula 

B. Sorti

ng 

C.Filteri

ng 

D. Pivot 

Answer : Filtering [Option : C] 

Q

. 

Statistical calculations and preparation of tables and graphs can be done using 

A. Adobe Photoshop 

B. Excel 

C. Notepad 

D. Power Point 

Answer : Excel [Option : B] 



 

 

 

 

 

 

Q

. 

Which one is not a Function in MS Excel ? 

A. SUM 

B. AVG 

C. MAX 

D. MIN 

Answer : AVG [Option : B] 

Q

. 

Functions in MS Excel must begin with    

A. An () sign 

B. An Equal Sign 

C. A Plus Sign 

D. A > Sign 

Answer : An Equal Sign [Option : B] 

Q

. 

Which function in Excel checks whether a condition is true or not ? 

A. SUM 

B. COUNT 

C. IF 

D. AVERAGE 

Answer : IF [Option : C] 

Q

. 

In Excel, Columns are labelled as    

A. A, B, C, etc 

B. 1,2,3 etc 

C. A1, A2, etc. 

D. $A$1, $A$2, etc. 

Answer : A, B, C, etc [Option : A] 

Q

. 

It is a collection of data that is stored electronically as a series of records in a 

table. 

A. spreadsheet 



 

 B. presentation 

C. database 

D. MS Word 

 

 
Answer : database [Option : C] 

Q

. 

What type of chart will you use to compare performance of sales of two products 

? 

A. Column Chart 

B. Line Chart 

C. Pie Chart 

D. Both A and B 

 

 
Answer : Column Chart [Option : A] 

Q

. 

In Excel, Rows are labelled as    

A. A, B, C, etc 

B. 1,2,3 etc 

C. A1, A2, etc. 

D. $A$1, $A$2, etc. 

Answer : 1,2,3 etc [Option : B] 

Q

. 

What do you use to create a chart? 

A. Pie Wizard 

B. Excel Wizard 

C. Data Wizard 

D. Chart Wizard 

 

 
Answer : Chart Wizard [Option : D] 

Q

. 

How will you graphically represent expenditure in different departments ? 

A. Column Chart 

B. Line 

Chart 

C.Pie 

Chart 



 

 D. Dot Chart 

 

 
Answer : Pie Chart [Option : C] 

Q

. 

What type of chart is good for single series of data ? 

A. Column Chart 

B. Line Chart 

C. Pie Chart 

D. Cone Chart 

Answer : Pie Chart [Option : C] 

Q

. 

The basic unit of a worksheet into which you enter data in Excel is called 

a 

A. cell 

B. table 

C. box 

D. column 

Answer : cell [Option : A] 



Attendance Register: 
 

 

 

 

 



 

Feedback form: 

Course feedback form: 

 

 
1. Were objectives of the course clear to you 

1)Yes 2). No 

2. The course contents met your expectations 

1) Yes 2) No 

3. The level of the course was 

1) Good 2)Not Good 

4. The contents were illustrated with 

1) More examples 2) Few examples 

5. The course exposed you to new knowledge and practices 

1) Agree 2) Not agree 

6. Will you recommend this course to your next Batch 

1) Yes 2) No



Critical Analysis Report: 

 

 

The Department of Statistics has been conducted a certificate course (Institutional Permission) 

on “Statistics - A do it yourself on EXCEL” from      01/07/2022                       to   

06/08/2022  with the minimum duration of 30 hours. According to the IQAC and Principals instruction the 

course have been started the feasibility and convenient of the hours for this academic year. The total students

 were registered for this course and completed as per the schedule. The objective of the course was 

fulfilled by acquiring of computing skills and problem-solving algorithms in EXCEL. 

Outcomes of the Course: 

 
1. Students can able to understand the statistical packages 

2. Students can able to maintain EXCEL sheets 

3. Students can able to Entering Data 

4. Students can able to Create Graphs like Line chart, Bar chart, Pie chart, Scatter plot, Straight lines 

5. Students can able to calculate Descriptive Statistics like Mean, median, mode, standard deviation, 

skewness and kurtosis in EXECEL 

6. Students can able to perform t- test, F-test, ANOVA 

7. Finally, students attended for test to know their acquiring skills in EXCEL 

 

 
 

Hence, the certificate course is very useful to B.Sc., Students on computing the problems easily in MS- 

EXCEL. The feedback from students were collected and analysed. All the students from Statistics showed 

interest to do such type of Certificate course and to continue it for further years also. 

 

 
Thankyou 
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GOVT.DEGREE COLLEGE, KODURU(RS), 

                       KADAPA (DISTRICT)  

 

                                               Department   Resolution copy 

 
 

 The department of Commerce arranged a meeting on 07-01- 2019 and resolved to conduct a Certificate 

course from the 19th January 2019 according to the feasibility of the Department of Commerce. It is 

also resolved to submit the details as per the check list given below well in advance by the 

department as per the requirements to run the proposed Certificate Course. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Notice Board 

The department of Commerce is going to conduct a certificate course on Tally from 

19/01/2019 to 26/02/2019 with minimum 30 working hours. Interested candidates are 

informed to register your names in the department on or before 18/01/2019. 

 

 

 

 

 



 

ACERTIFICATE COURSE ON TALLY 

 

 

Vision 

The vision of this Certificate course in Tally gives a comprehensive study of basic 

functionalities of finance and accounts. This course encompasses all critical aspects of an 

organization, including pay roll, inventory, manufacturing and banking to name a few. “Tally” 

is comprehensive ERP software that goes far beyond the basic functionalities   of finance and 

accounts. True to its spirit, Tally optimization organization’s various operations and divisions, 

streamline sever aspect, and brings together its functioning into a cohesive whole. Over the 

years, Tally has become synonymous with accounting and accounting is nothing but 

maintaining different books of accounts. Thus, this certificate program is envisaged and is 

being delivered for the benefit of aspiring accounting professionals and students in the 

Finance and Accounting streams. 

 

 

Mission 
 

The Mission of the Certificate course in Tally is to: 

(i) Empowering the learners by giving the basic knowledge on the usage of Tally 

software; 

(ii) Train the students on Tally; 

(iii) Assist the students with the in academic needs and helping them to 

          improve the knowledge for allied subjects also; 

(iv) Provide quality programs for learners with specialized skills sets in the 

          develop and conducting the quality proficiency assessment ; and 

(v) Contribute to the growth and progress of the learners. 

 
 
 
 
 
 
 
 
 



 
 

Objectives of the course:  

 
It is an industry oriented training program, designed to competently prepare candidates in the 

fine aspects to make a suitable entry into the corporate world. Fresh Graduates are molded to 

analytically think and skillfully communicate which translates into a perfect and job profile 

match to the expectation of Organization. Tally certification enables the students to become a 

seasoned accounting professional in the shortest possible time. And, since Tally is currently 

used across diverse segments like MNCs, government & local businesses, job opportunities with 

the best companies in the country are immensely enhanced. 

 

 

 

Course Outcomes: 
After Completion of the subject student should able to 

 
 Certified Recognition from Tally Academy. 

 Thorough understanding of Electronic Accounting. 

 Multi location with Multi disciplines. 

 Competent, qualified and experienced Trainers. 

 Training customization option. 

 Flexible & Responsive Approach. 

 Pre and Post training assessments. 

 Skills required for selection processes. 

 Ability to demonstrate skills and competence in the most effective 
                   manner during interview. 

 Experience a major progressive overall change in self positive 
                  enhancement of knowledge, efficiency and productivity through best of 

                    practices. 

 
 

 

 

 

 

 

 

 

 

 



 

 

Course Structure:  
 

The structure of the proposed Certificate Course in Tally is a basic level certificate on course 

in the area of Accounting Software using in the domain of Accounting and Finance. Primarily, 

the certificate program in Tally is aimed at imparting basic knowledge and skills of several 

applications using in the Tally. It is evident that the landscape of the today’s business world 

is changing very drastically due to the advent of science and technology, particularly internet 

and internet enabled things. Hence, It is need to update the required skills in the area 

Accounting and Finance by using Accounting Software’s like Tally.  Thus, the course is 

designed to address the immediate  needs of the students after graduation in their attempt to 

go for further studies or to seek employment. 

 

Syllabus:  
 

Getting started with Tally: 

What is Tally? Using Tally Software: introduction and installation/Required 
Hardware/Preparation for installation of  tally  software/installation.  
 
Items on Tally Screens: 
Menu options/creating New Company/Base Currency information/ New Company/ Other 
information/ Company features and inventory features.  
 

Configuring Tally: 

General/Number symbols/accts/voucher entry/invoice/orders entry and printing/  security 
issue.  
 

Reports in Tally: Output reports/ basic features of displaying reports/ printing 
reports/other printing options/ display account books and statements/ viewing cash/ bank 
books/ configure balance sheet.  
 

Preparation of Trail Balance: 

Accounts books/ Cash Book/Bank Books/Ledger Accounts/Group Summary/ Sales Register 
and Purchase Register/ Journal Register/ Statement of Accounts/ &Balance Sheet. 

 
 
 
 
 
 
 

 

 

 

 



 

 

Study Material/ Notes 
 

Introduction Tally 9.0 

 
Tally Solutions has released a new version of its Tally 9 software. It is most popular software for 

accounts and inventory management. It offers different feature forming accounts. Tally 9 is integrated 

with a lot of advanced feature like better data migrating, fast data speed, payroll management, TDS, 

TCS, job costing and point- of sale invoicing etc. 

 

Tally 9, a synchronized multi lingual integrated business accounting software, enables to maintain 

accounts in any Indian language, view it in other and printing other language of their choice. Targeted 

at SMBs, Tally 9 offers greater reliability, scalability, accuracy and speed. It supports Unicode data 

which helps companies maintain data in any of the Unicode supported languages. 

 

Tally 9 program also has features including tax compliance features for value added tax(VAT),service 

tax and excise for traders. 

 

FEATURESINTALLY9 

1. Easy calculation of TDS(Tax Deducted at Source) 

          Using Tally9 you can calculate TDS appropriately. 

2. Negative Stock Warning in Journal Voucher 

Create a stock item with an opening balance of considerable units and pass a delivery note against it 

.using a Journal Voucher to record a sales transaction tracking the delivery note would display a 

warning message of negative stock even through a considerable amount of stock was left over. The 

same has been addressed appropriately in Journal voucher. 

3. Performance in Networking Environment 

Tally 9 can work efficiently in a networking environment, if the Server has Windows XPand Clients 

have Windows 98 as the operating system, Tally performs efficiently with improved data stability. 

4. Interest calculation in Forex 

A Sales transaction created using Forex currency and Interest calculation, calculates the Outstanding 

Forex Interest accurately. 

5. Ledger Account 

Tally now prints the address of the Sundry Debtor/Creditor ledgers, while printing a ledger account. 

6. Ratio Analysis 

If the Net Profit is lesser than the Return on Investment % or Return on Working Capital, Tally displays 

the values with a negative sign. 

7. Maintain balances bill by bill 



Altering a ledger created under Sundry Debtors or Sundry Creditors, by setting Maintain balances bill 

to bill only the selected ledger and not the Group. 

 

8. Migration Tool 

Users may now migrated to Tally9, using the Tally Data Migration Tool on Tablet PCs and Desk top 

computers of higher processor speed. 

9. Stock Journal 

The value in the rate field of a Stock Journal(Transfer of Materials)appears  appropriately. 

10. Purchase/Sales Order 

The list of Party or Customer ledgers is displayed appropriately, while creating a Purchase/Sales order 

respectively. 

11. Inventory Report 

The Godown–wise Inventory reports move displays accurate balance values where as multiple godowns 

are maintained. 

12. VAT(Value Added Tax) 

You can calculate value added tax in tally9. 

13. FIFO Perpetual 
 

Tally introduces a new method of inventory valuation FIFO Perpetual, which is similar to LIGO 

Perpetual. The Normal FIFO treats the opening balance of the financial year as the terminating rate to 

apply for residual stock. FIFO Perpetual takes all existing past data. Both LIFO and FIFO Perpetual are 

capable of changing the valuation when the company is split unlike their‘ Annual’ versions, which are 

consistent. 

 

14. Payroll 

It has been integrated with accounts in order to simplify Payroll processing. Payroll can be configured 

to suit the requirements of various types of organization. 

 

15. POS Invoicing 

POS Invoicing in Tally is equipped with ease of use and advanced capability to simplify your retail 

operations. It efficiently automates the‘ check–out’ process, and allows you to create invoices and 

collect payments from customers, in a matter of moments. 

 

16. Multilingual Support 
Tally comes with the World’s First Concurrent Multilingual Business Accounting & Inventory 
Management Software for small and medium businesses. The user interface for the software is available 

in Hindi, Marathi, Gujarati, Bengali, Kannada, Tamil, Telugu, Malayalam, Hinglish(colloquial English) 

and Punjabi, and in Bahasa Melayu and Bahasa Indonesia allowing you to interact with Tally, in a 

language of your choice. 
 

 

INSTALLING TALLY9 
When you install Tally, a folder named Tally is created by default, where the program files will reside. 

You can specify a different folder name, if you wish. 

 



 
 
 
System Requirements 

 
To install Tally, your system must meet the following minimum requirements. 

 

 
Processor Intel Pentium IV and higher or equivalent 

Memory 256MBRAMormore 

Free Hard Disk Space 40MBMinimum(excluding the data)_ 

Monitor Resolution Recommended1024*768orhigher 

 
 

Note:For better performance Tally Multilingual needs more memory(about 

40MB of Free Hard Disk Space) 
 

To install Tally in Windows NT/2000/XP/2003/XPSP2/VISTA Work station, 

 

1. You need to have administrator/all rights(to create, write, update, 

modify and delete) on the Application. Data, Configuration and Language 

directory. 

2. Ensure that the Operating System you use supports Tally for Multilingual support. 
You can install Tally using one of the given methods. 

 
Method1: 

 
 Double click install.exeformtheCD. 

 
Method2: 

 
 Click STARTfromWindows. 

 

 SelectRUN. 

 

 TYPE<CDdrive>:/INSTALL. 

 

 Press ENTER key. 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 
Follow the instructions on your screen to install Tally. 

 

1. The Tally Setup Wizard is displayed. 

 

 

 

2. Click Next to continue 

 

3. The Installation wizard displays the License Agreement. Read the license 

agreement before you proceed. Click I Agree to continue. Click I Decline to 

stop setup or click Back to go to the previous screen. 

 

4. In the Installation screen, you may accept the suggested directories. Else 

click Change Application Directory or Change data Directory or Change 

Configuration Directory or Change Language Directory the change the 

respective directory paths. Use Tab or the mouse to change the path in any of 

the directories. 

 

 

 

 

 

 

 

 

 

 



 

 

 

Sl. No. Name of the Student Group Class/ 
Year 

Remarks 

1   B.LAKSHMI PRASANNA B.Com II  

2   C.SATISH KUMAR B.Com II  

3   K. HARI KRISHNA B.Com II  

4   M. LEELA KUMAR B.Com II  

5   M. SUKUMAR B.Com II  

6   S. SWATHI B.Com II  

7   M. GUNTANNA B.Com III  

8   M. KAVITHA B.Com III  

9  P. RAJESWARI B.Com III  

10   T. KARUNAKAR B.Com III  
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 FEEDBACKFORM 

 
1. 

 
Were the objectives of the course clear to you? 

(i) Yes 

(ii) No 

2. Did the course contents meet your expectations? 

(i) Yes 

(ii) No 

3. The level of the course was 

(i) Good 

(ii) Not Good 

4. The contents were illustrated with 

(i) More examples 

(ii) Few examples 

5. The course exposed you to new knowledge and practices 

(i) Agree 

(ii) Not agree 

6. Will you recommend this course to your next batch 

(i) Yes 

(ii) No 



TEST 
 
 

1.WhatisTally? 

 a)Asoftwareusedforaccountingpurposesb)Asoftwareusedforvideoediting 

c)A soft ware used for graphic design 

2.What is the full form of VAT? 

 a)Value Added Tax b)Variable Annual Turnover)Virtual Account Tracker 

3.Which is the right choice from the following? 

 a)Purchase   Order 

b)Sales Order   c)Receipt Voucher 

 

4.Which key is used for selecting a company in Tally? 

 a)Alt+F1     b)Alt+F2        c)Alt+F3 

5.What is the short cut key for creating a new voucher in Tally? 

 a)F5 

 

 b)F6               c)F7 

 

6.Which report in Tally shows the profit and loss of a company? 

 a)Balance Sheet    b)Trial  Balance     c) Profit and Loss A/C 

7.Which feature in Tally allows you to create a backup of your data? 

 a)Export              b)Import              c)Backup 

8.What is the short cut key for selecting a company in Tally? 

 a)Ctrl+A       b)Ctrl+F1             c)Ctrl+F2 

9.Which voucher in Tally is used to record a payment made to a supplier? 

 a)Payment Voucher      b)Receipt  Voucher       c)Sales  Voucher 

10.Which Tally feature allows you to maintain inventory levels? 

 a)Stock Summary     b)Balance   Sheet    c)Profit  and  Loss A/C 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

             THE DEPARTMENT OF COMMERCE 



             Critical Analysis Report 

The Department of Commerce has conducted a certificate course (Institutional Permission) 

on Tally from 02/08/2017 to 13/09/2017 with the minimum duration of 30 hours. 

According to the IQAC and Principal’s instruction, the course has been conducted as per the 
feasibility and convenience of the Department of Commerce and availability of the students 
during this academic year. 16 students were registered and completed the course as per the 
schedule. The objectives of the course that were specified in the beginning of the course were 
fulfilled to the core. 

Outcomes of the Course 

 Students could come to know the basics Tally and its applications. 

 Students could use the Tally application on their own. 

 Students could work on the present business environment with the help of 

                   tally software. 

 Students could fill the gap between the academia and industry with their 

                  expertise knowledge in the area of accounting and finance. 

 

Hence, the certificate course on Tally is very useful to all the Students. The feed back from 

the students was collected and analyzed. All the students from across the streams showed 

interest to do this Certificate course and requested to continue the same course further for 

the successive batches. 
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                                    Department   Resolution copy 

 

 

 The department of Commerce arranged a meeting on 23-08- 2019 and resolved to 

conduct a Certificate course on “Retailing” from the 3rd September 2019 

according to the feasibility of the Department of Commerce. It is also resolved 

to submit the details as per the check list given below well in advance by the 

department as per the requirements to run the proposed Certificate Course. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Notice Board --  26-08-2019 

 

The department of Commerce is going to conduct a certificate course on 

“Retailing” from 03/09/2019 to 26/02/2019 with minimum 30 working hours. 

Interested candidates are informed to register your names in the department on or 

before 03/09/2019. 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 



 

CERTIFICATE COURSE IN RETAILING 

 

Certificate Course in Retailing is focused on fundamental retail topics and provides 

students with the ability to choose electives based on broad interests or specific 

areas such as buying operations, or management. Certificate Course in Retailing 

explains of retail category management, retail store operations, performance metrics 

and designing marketing and promotional strategies. 

Certficate Course in Retailing  Syllabus 

1. Introduction to Retailing: Concept of retailing, Functions of retailing, 

Terms & Definition, Retail formats and types, Retailing Channels, Retail 

industry in India, Importance of retailing.  

2. Retail Framework and Retail Strategy: Market Segmentation and its 

benefits, Kinds of markets, Definition of Retail strategy, Strategy for 

effective market segmentation, Strategies for penetration of new 

  markets, Growth strategies, Retail value chain.  

 

3. Trends in Retailing: Changing nature of retailing,  

 Organised   Retailing, Modern retail formats, E-Retailing, Challenges 

 faced by the retail sector 

 

4. Merchandise Management: Meaning of Merchandising, Factors      

  influencing Merchandising, Functions of Merchandising Manager, 

  Merchandise planning, Merchandise buying, Analysing   Merchandise 

  performance 

 

5. Technology in Retail : E-Commerce, Friendly POS System, Machine     

   Learning for Demand Forecasting, Data Science – Based on Personal 

   Interaction, Staff – Free and Cashier- Less Stores, Voice Commerce, 

    Robotic. 

 

 

 

 

 

 

 

 

 

 

 

 



 

Objectives of Certificate Course in Retailing: 

 Certificate Course in Retailing is the right course for aspirants who would 

like to become retail professionals at supervisory levels and those who own 

or management a retail business. 

 The course also equips the participants with the tools and terminology that 

will be required to survive and grow in this ever-growing sector. 

Course Outcomes: 

 After passing the course they can go for further higher degrees for enhancing 

their educational qualifications and for promotions. 

 Certificate Course in Retailing gives real-world understanding of what does 

in the complete retail sector and prepare the participants to get ready for the 

rewarding career in the retail in the course sector. 

 They can have so many jobs in the transportation and logistics sectors. 

Certificate Course in Retailing Employment Areas 

 Advertising Agencies 

 Colleges & Universities 

 Departmental Stores 

 Movie Theatres 

 Super markets 

 Supply Chains 

Certificate Course in Retailing Job Types 

 Brand Manager 

 Category Manager 

 Department Manager 

 Project Manager 

 Retail Buyer 

 Sales Manager 

 Stores Manager 

 Supply Chain and Logistics Manager. 

Course Duration:  30 Hours.  

 

 

 

 

 

 

 

 

 

 



SUMMARY REPORT  

 

 

ACADEMIC YEAR: 2019-2020 

 

 

 

 
 

The Certificate Course student has made significant progress in Retailing. Seminars were 

conducted all the students on the topics of Retail formats and types, Retailing Channels, Retail 

industry in India.  In addition to theory classes students are visited some of the retail stores in 

Kodur in the month of November 2022.  

Assessment of students was carried out on the basis of internal evaluations which include 

Attendance, Assignments, and Viva during training. Twenty two students are completed the 

Certificate course on “Retailing”. 
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          CERTIFICATE 

GOVT DEGREE COLLEGE KODUR(RS) 

ANNAMAYYA, DIST. AP.  

Affiliated to Yogi Vemana University, Re-accredited by NAAC with ‘B’ Grade 
 

 

This is to certify that _____________________________,  ____ year B.Com(CA or General), GDC KODUR(RS), 

Kadapa Dist. has successfully Completed Certificate Course on “Retailing”. Organised by Department of Commerce, 

Government Degree College, KODUR(RS) from 03-09-2019 to  23-10-2019 

 

             Coordinator                                                                                        HOD of Commerce                                                                    

 

 

 

PRINCIPAL 
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CERTIFICATE COURSE  

 

“MS OFFICE(WORD & POWER POINT)” 
 

2018-2019 
             

  
          
 



                    Department of Computer Science 

 
 

 

Resolution Copy 

 
 

As per the circular issued by the IQAC dated        24-01-2019 the Department of 
 

 Computer Science has decided to conduct a  Certificate  course from  28-01-2019  to 

28-02-2019  and duration of course is 30 hours.  

 

 

 

        
             

 

                                                                                                                       LECTURER INCHARGE 

                                                                                                       DEARTMENT OF COMPUTER SCIENCE 

                                                                                                                           GDC, KODUR(RS) 

                                                                                                                             KADAPA(DT) 

 

 

 

 

 

  



                                                                                                                                   Kodur 
25-01-2019. 

From  
 
K.Uma Maheswari, 
Contract  Lecturer in Computer Science , 
Govt. Degree College, Kodur(RS), 
Kadapa(Dt). 
 
To 
 
The Principal, 
Govt. Degree College, Kodur(RS), 
Kadapa(Dt). 
 
Respected Sir, 
           
           Sub: Request  permission for conducting Certificate Course on 
               
                   ” MS-OFFICE(WORD & POWERPOINT)”  –  Reg,.  
 
      --- 
 
     This is bring to your kind consideration that Department of Computer Science is 

planning to conduct a Certificate Course for all group students in ”MS-OFFICE(WORD & 

POWER POINT)”  with minimum of 30 hours during the Academic Year 2018-2019. 

Hence I request you to grant permission to start the Certificate Course from 28-01-2019 

to 28-02-2019. This is for your kind information. 

 
  Thanking you Sir, 
 
 
 
            Yours faithfully, 
           
  
          (K.Uma Maheswari) 

           

 

 

  



GOVERNMENT DEGREE COLLEGE, KODUR(RS), KADAPA(DT) 

DEPARTMENT OF COMPUTER SCIENCE 

 

Circular 

 

                       The  D epartment of Computer Science is going to conduct a certificate course on ”MS-

OFFICE(WORD & POWERPOINT)” wiith min 30 working hours from 28-01-2019 to 28-02-2019. 

Interested candidates should come and register your names in the Department of Computer Science on or  

before  28-01-2019.     

 

 

 

 

 

 

 

 

      

  

         LECTURER INCHARGE                                                            PRINCIPAL       

  DEPARTMENT OF COMPUTER SCIENCE              GDC, KODUR(RS) 

             GDC, KODUR(RS)       KADAPA(DT) 

                KADAPA(DT) 

                  



About the Course 
 

Context and Significant of Course: 
 

 

 

 

 

 

 

 

 

 

 

 

      MS-OFFICE is a Package which contains Word, Power point, Excel and Access and so on. 

Ms-Word 

 Microsoft Word or MS Word is a popular word-processing program used mainly for creating 

documents, such as brochures, letters, learning activities, quizzes, tests, and students' 

homework assignments.  

 It was first released in 1983 and is one of Microsoft Office suite's applications. 

 The file extension of a saved document  is “.doc”. 

 

Ms-Powerpoint 

 MS-Powerpoint was created in a software company named Forethought, Inc. by Robert 
Gaskins and Dennis Austin.  

 It was released on April 20, 1987, and after 3 months of its creation, it was acquired by 
Microsoft. 

 It is a presentation-based program that uses graphics, videos, etc. to make a presentation 
more interactive and interesting. 

 The file extension of a saved Power point presentation is “.ppt”. 

 A PowerPoint presentation comprising slides and other features is also known as PPT. 

 

SNO Content Details of the Content 

1 Name of the Course ”MS-OFFICE(WORD&POWER POINT)” 

2 Duration  30 days 

3 Conducted by Department of Computer Science 

4 Number of  students 
Registered 

23 

5 Resource person K. Uma Maheswari 

6 Date from 28-01-2019 to 28-02-2019 



 
Course Objectives: 
 
Ms-Word is used to      

 Create, edit, save, and print documents to include documents with lists and tables. 

 Format text and to use styles. 

 Add a header and footer to a document. 

 Add a footnote to a document. 

 Add a graphic to a document. 

 Use the Spelling and Grammar Checker as well as Microsoft Help. 

 Manipulate documents using functions such as find and replace; cut, copy, replace. 

Ms-Power point is used to 

 Create Presentations with different themes 

 Prepare Seminar topics with colorful fonts and images 

 Prepare animations effectively and so on 
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                        Certificate Course Syllabus(Word & Power point)  
 
                                                                  Unit-I 

 
 New, Open, Close, Save, Save As 

 Text Formatting and saving file   

 Formatting Text: Font Size, Font Style Font Color, Use the Bold, Italic, and Underline 

 
                                                       Unit-II 

 
 Text Basics  Alignment of text 

 Editing Text: Cut, Copy, Paste, Select All, Clear 

 Find & Replace  

                                             
                                                            Unit-III 

 Change the Text Case 

 Line spacing, Paragraph spacing 

 Shading text and paragraph 

 Working with Objects  Shapes, Clipart and Picture, Word Art, Smart Art   

 
                                                      Unit-IV 
 

 Creating Presentation 

 Adding New slides─ Adding Text in Boxes-Adding New Text  

 Deleting Existing Slide  

 Arranging slides  

 Rearranging Slides 

                                                                         Unit-V 
 

 Adding Cliparts, Pictures, Images, Objects and so on 

 Custom Animations  

 Inserting Audio/Video files 

 Slide transition 

Outline of the course in periods: 

1. Theory hours                 15       

2. Hands on experiment    15    Total -30 hours 
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ENTER 

   MS-WORD 2007 
 

 

 

Microsoft Word or MS-WORD is a graphical word processing program that users can type with. Its purpose is to 

allow users to type and save documents. Similar to other word processors, it has helpful tools to make documents. 

 
This notes is useful for a beginner to learn the operations of MS word (version 2007) through practice. 

Exercise : 1. Typing a document. 
Any printed matter is referred to as a document. Ex. A research paper, Leave letter etc. The following 

points are useful to prepare a document 

 

To Open MS- WORD : Click at the menu items as shown below 

Now a document is opened. 
 

 

Points to remember : 
1. Start typing a paragraph after leaving a tab space by pressing the key 

 

2. Type Continuously till the end of the paragraph. Press key to go to the next 

para. 

TAB 

Start Programs MS- Office Word 



Ignore Change 

F7 

3. Selection of a text: Take the Cursor to the beginning of the line- Click the mouse and drag 

till the end of line. The selected portion will appear in the reverse video (Black background 

and white letters). Now apply the following for special appearance 

 

 
 

Bold space 
 

Italic 
 

Underline the text 
 
 

4. Font: Selecting different Fonts may change the style of the text. To apply a font, 

select the portion of the text and then do the following 
 

Click here and select a font 

 

Example : Arial Black Tahoma Comic Sans MS 

Similarly the size of the text may also be selected : 12 18 24 

 
5. Text alignment: A line or a paragraph may be aligned in the following manner. 

 

Take the cursor to the line or para by clicking on it, and press any one of the justification buttons 

 

 
Normally paragraphs are left justified and the Headings are Center justified. 

 

6. Line Space : 
The line space is adjusted by pressing the following keys together 

7. Spell Check : 
Press key to begin the spell check.  Once the checking is going on the computer would 

suggest some corrections. You may accept by pressing or Press 

 
(Or) Right Click at the wrong word – The suggestions are displayed – Click at the chosen word. 

B 

 

I 

U 

Times New Roman 

Left justified Center justified Right justified 

Ctrl 1 
5 Ctrl 



 

8. To Save : 
 

Give the file name and press 

 
 

9. To Print : 
 

 

Specify the page numbers to be printed and press 

 

10. To open a Previously Created document  

 
Exercise : Re type the following text with all the effects displayed in this Text, including font, font size, font 
effects like Bold, italic and underline (though the text is not a professional presentation ) 

 
 

Exercise : 2. Preparing a Greeting Card using Word 
Prepare a card as shown below 

 

 

Steps : 

1. Open a new Document  

 
2. Insert a Picture : 

 

Select a picture from the Clip art gallery. Right Click the mouse 

Minimize the clip art menu – Go to document: Paste 

Copy 

Clip Art Insert 
Organise Clips 

New OK 
Blank 

Document 

Open 

OK 

Print 

Save 

Save 

Wishes for a 

Happy e Learning 

Sahaya Baskaran 



OK 

Now the clip art is inserted. Right click the mouse, on the clip and press 
 

Now the size of the picture may be modified and moved to any position by click and drag method. 

 

3. To get a border : 

 

 

Select the desired border style and size and press 

 

Note : Page Colour, Water mark options are also available in this menu 
 

4. Word Art : Word art is used to get attractive style of letters. It is under INSERT menu 

 

Exercise : 3 . Typing a document –Additional features 

1. Page Set up : This is used to set the size of the paper to be used for printing, 

as well as margins for the page. 
Open a New Document. 

 
 

Now a new document is created 
 

 

Set the width and height of the paper ( in inches) and press 

 

To Set the Page Margins: 
 

 

Select a predefined style. (OR) click at 

 

Set the Top, Bottom, Left and Right margins (in inches) 
 

and press -- The margins selected are left blank while printing. 
 

NB : The menu is used to change the orientation of the paper for printing. 

(Landscape / Portrait) 

Custom Margins 

OK 

New OK 
Blank 

Document 

OK 

Page Borders Page Layout 

Text Wrapping Behind Text 

Page border BOX 

Page Layout Size More Paper Sizes 

Page Layout Margins 



Example: The following lines are indented from left margin. All the lines start after leaving some 

space from left margin. 

The use of indentation is get the text pushed inside. The indented text is automatically 

pushed till we press ENTER key. After pressing ENTER key press Decrease indent 

key once. 

Home 

2. Bullets : Bullets are used to fix bullet symbols to each line of the text. 

Go to menu; press button and then type the text. 
 

The bullets are given automatically to every line. Press ENTER key to go to next line. To stop the bullets 

: Press  BACKSPACE key in a new line. 

NB : Automatic Numbering may also be given to the document in a similar way. To get automatic numbering Press 

 

 
 

This type of Auto Numbering is very useful for typing references to the Research paper/ Thesis. When we add / 

delete some references from the text, the line numbers are automatically adjusted. 

 

3. Indent : Indentation is used to type some quotations. 

There are two buttons to Decrease / Increase indent 

 

 

 

 

 

 

 

 

 

 
 

  

Example: 

 Solids 

 Liquids 

 Gases 



F5 

MS-POWERPOINT 2007 
 

 

Power Point is used for creating presentations (Seminar presentation, Quiz, Animated Shows, Photo Shows, etc). It 

is a part of the package MS-Office. This presentation puts forward a simple and easy way to learn the package. 

 

Open PowerPoint 
 

The title layout of the PowerPoint will be displayed. Click and type the title of the presentation. 

 

To Get a new slide : 
 

 Select a layout from the available list. Layout refers to the outline of the slide. 

 Select the title and Content layout : This layout has Table, Chart, Smart art graph, Picture, Clip art 

and Movie clip. 

 Select a suitable layout and fill the required items. Example : Select a picture lay out- by clicking at 

the picture icon, insert a new picture. 

By using the previous steps, create more number of slides (say 7 slides). 

To View the Slide Show : 
 

(or) Press key 
 

 Now the slides are displayed one after another by pressing Enter key/ Mouse click. 

 Use arrow keys to go to previous / next slide. 

 Press ESC key to stop the slide show. 

To Change the background : 
This option is used to get beautiful backgrounds for the presentation. 

 

Choose a design and select it by clicking on it. We may change the slide orientation, colours, effects, fonts and 

background graphics at this level. 

Animation : 
The display can be made more impressive by introducing special effects like displaying the text with some 

visual effects.  Animation can be done at two levels 

1. Slide level transition 

2. Object level Effects 

1. Slide level transition : This will effect the slides being displayed 

 
Select a transition style for the slide. 

 
Now all the slides will appear according to the chosen transition. 

 

We can give sound effect also by selecting a proper sound clip from the TRANSITION SOUND list box. The 

speed of transition can be controlled by selecting an option from the TRANSITION SPEED list box. 

PowerPoint Program START 

New slide Home 

Slide Show View 

Design 

Animations 
Apply to all 



Custom animation Animations 

2. Object Level : This is used to produce special effects to various objects in the slide ( 

Text, Picture, Chart .. etc) 

 
 

Select an object in the slide by clicking at it, and then click at 
 

Select the animation style from the list box by clicking on it. 

It also has speed control, direction control and options for changing / removing animation. 

 

Slide View options 
 

 Normal View : Used for designing the slides. 

 Slide sorter View : All the slides are displayed. This view is used 

to change the order of the slide, delete a slide etc. 

 Note Page view : To add some notes to the slide. 

                   This may be useful 

to the presenter and will not be displayed. 

To save :                                  

                              type a file name 

  

To Open a previously saved presentation  : Select the file 

 
 

Inserting a Header / Footer for all 
pages : 

Open the slide in NORMAL view. 

 
 

Select the FOOTER. Type the text to be added as footer. 

 

Some tips for effective presentations 
 

There should be a good contrast between the foreground (letters) and the background. It is 

advisable to use default designs. (Example : black letters with white background has the maximum 

contrast. Black letters with a blue background is to be avoided) 

1. Font size : 22- 40 . Smaller fonts will not be visible to the audience. 

2. The line space for text may be 1.5 / 2 for better visibility. 

3. To break the overcrowded text in to two slides: Click at the slide (ctrl+D). Now you get a 

duplicate slide. Remove the second part from the first slide. Remove the first part from the 

second slide, and readjust the font size. 

Avoid hyperlinks from the text copied from internet. (Right click, REMOVE HYPERLINK) 

  

Save 

Open 

Slide Header and Footer Insert 

Apply to All 

Add Effect Entrance 
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Assessment of Certificate Course:2018-2019 

 

Name of the Student:  

Class & Group          : 

 
1)MS-Word is used to create _______ 
 
(A) Worksheet(B) Document(C) Slide(D) None of the above 
 
2)Microsoft word is ____ software. 
 
(A) Application (B) Compiler(C) System(D) Programming 
 
3)The ___ works with the standard Copy and Paste commands. 
 
(A) View tab(B) Paragraph dialog box(C) Office Clipboard(D) All of these 
 
4)Which of the following is an example of page orientation? 

 

(A) Landscape(B) Subscript(C) Superscript(D) A4 

 

5)Short cut for saving the document 

 

(A) Ctrl+P (B)Ctrl+O (C) Ctrl+S (D)None  of the above 

 

6)Which of the following software is used for making resume? 

 

(A) MS Excel(B) MS Word(C) Dev C(D) Java 

 

7)Power Point is used to create ________ 

 

(A) Slides (B)Document (C) Text (D) Worksheet 

 

8)Power Point is used to prepare Seminar Topics 

 

(A) True(B)False 

 

9)Power Point is used to prepare the following 

 

A) Cliparts (B)Pictures (C) Objects (D) All the Above 

 

 

10)Which application is most suitable to prepare animations 

 

A) Ms-word(B)Ms-Powerpont(C) Excel (D) Access 

  



Photos 

 

 
 

 

 

 

 

 
 

 
 


	Govt. Degree College, Kodur (RS), Kadapa Dt.
	Certificate Course
	Check list:
	2. Department wise Resolution
	a. Date and timing schedule
	c. Testing procedure
	e. Model Certificate
	5. Attendance register for 30 hours and more (Online/ Offline)
	7. Test(Exam) and Certificate distribution
	DEPARTMENT OF COMPUTER APPLICATIONS
	Certificate course on Digital Awareness
	Object of the course:
	COURSE OUT COME
	Student Enrolment list:
	GOVT.DEGREE COLLEGE: KODUR(RS)
	Check list: (1)
	2. Department wise Resolution (1)
	a. Date and timing schedule (1)
	c. Testing procedure (1)
	e. Model Certificate (1)
	5. Attendance register for 30 hours and more (Online/ Offline) (1)
	7. Test(Exam) and Certificate distribution (1)
	Department Resolution Copy Department of  Statistics
	Notice Board
	DEPARTMENT OF STATISTICS:: GDC, KODUR
	Object of the course: (1)
	COURSE OUT COME (1)
	Student Enrolment list: (1)
	Creating a new spreadsheet:
	Opening previous spreadsheet:
	Managing the spreadsheets:
	To save the workbook:
	To share your workbook:
	Ms-Excel shortcuts:
	Excel screen
	Descriptive Statistics
	Create a Chart
	Change Chart Type
	Switch Row/Column
	Legend Position
	Data Labels
	Pie Chart
	Scatter Plot
	Straight Lines
	Column Chart
	Line Chart
	Histogram
	Descriptive Statistics (1)
	Statistical Functions
	Min
	Max
	Large
	Small
	Correlation
	Regression
	t-Test
	F-Test
	Model Question Paper:
	GOVT.DEGREE COLLEGE, KODURU(RS),
	KADAPA (DISTRICT)
	Department   Resolution copy
	Notice Board
	ACERTIFICATE COURSE ON TALLY
	Vision
	Mission
	Objectives of the course:
	Course Outcomes:
	Course Structure:
	Syllabus:
	Introduction Tally 9.0
	FEATURESINTALLY9
	INSTALLING TALLY9

	TEST
	Critical Analysis Report
	Outcomes of the Course
	Department   Resolution copy (1)
	Notice Board --  26-08-2019
	Department of Computer Science
	Resolution Copy
	DEPARTMENT OF COMPUTER SCIENCE
	Circular
	MS-WORD 2007
	Exercise : 1. Typing a document.
	Points to remember :
	Bold space
	6. Line Space :
	7. Spell Check :
	8. To Save :
	9. To Print :
	10. To open a Previously Created document

	Exercise : 2. Preparing a Greeting Card using Word
	Prepare a card as shown below

	Exercise : 3 . Typing a document –Additional features
	To Set the Page Margins:



	MS-POWERPOINT 2007
	Open PowerPoint
	To Get a new slide :
	To View the Slide Show :
	To Change the background :
	Animation :
	Slide View options
	Inserting a Header / Footer for all pages :
	Some tips for effective presentations



